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Introduction

This document is designed to guide you through the security & permissions and associated
functions available within DocMoto.
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Permissions

Permissions can be set against any DocMoto folder or file. All permissions are applied on a
group basis. That is members of a group are given access to the folder or file. By default,
permissions are inherited from the parent folder. When setting permissions, the options are as
follows.

Fig. Permissions

Permission Effect on Folder Effect on File

No Access Not displayed Not displayed

Read Only Include in parent's folder list Include in parent's folder list, can download

Read & Write Create sub folder, add file Check-out, check-in, cancel check-out, download

Read, Write & Create sub folder, add file, delete self ('this' Check-out, check-in, cancel check-out, download, delete
Delete folder) self ('this' file)

Full access plus the right to set permissions for

other groups Shares ownership

Administer

Groups

A "Group” is a collection of users. All security is applied at group level. A user can be a member
of multiple groups and with regard to permissions the highest level of access will apply. For
example, a user is a member of two groups, “Sales” and “Managers”. A folder has permissions
set such that the group “Sales” has no access and the group "“Managers” has full access. A user
who is a member of both groups will have full access to the folder.

DocMoto has two predefined top level groups, “users” and “administrators”. All new groups will
be nested within the group “users”.

Users

A DocMoto user maps to a real person and the users credentials are used to log into the
DocMoto Server.

A user’s attributes are:

Login — The user’s login. A login is not case sensitive and should not contain:
o Whitespaces
o Special characters (i.e. !|@£%#)
e Real Name - The name that is shown in DocMoto regarding a user action ie: who
checked-in a file.
e Email - The user's SMTP email address. This is used by DocMoto’s notification and
subscription system. If left blank subscription will always be disabled for this user.
¢ Allow Sharing — Controls whether a user can create shares.
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e Inactive — Sets the user inactive effectively removing them (as a user against the licence)
but not deleting them. This is advantageous in that a full audit trail is kept for the user

and is available for query. Generally, users should be set to inactive rather than deleting
them.

Setting Permissions

Permissions can be set against both folders and files. Permissions are group based. All members
of the "administrators” group can set permissions as can any other groups given “administer”
rights to the file or folder. The application of permissions is designed to be fast and simple
particularly with large numbers of files, folders and user groups.

Setting Permissions — against an existing folder

1. Select the folder to set permissions against.
2. Select the “Permissions” option from either:
a. The “File” menu.
b. By right mouse clicking on the folder and selecting from the popup (or action)
menu.
c. The “shift + cmd + p” shortcut./
3. A Permissions dialog is presented as shown in Fig. Permissions dialog (folder).

Fig. Permissions dialog (folder)

® El contents
localhost | <) =2 e
Accounts
DocMoto Name ledBy  Comment
[ contents > # Apple Default Privileges : (Inherit from Parent) |~ ]
e > 1. OCR Inbox
0 Home » 1000 plus files Group Privileges
T Trash " Admin engineering (Inherit from Parent) Inistrator
r Assembly legal (Inherit from Parent) inistrator
_ v Bl CHL Software manager (Inherit from Parent) [nistrator
GBI v I Accounts projects (Inherit from Parent) Inistrator
Active Clients » 2012 users (Inherit from Parent) inistratar
2013 inistrator

Active Projects 2014

2015
2016
2017
2018
Last Will And Testaments 4 Company Documents {Inherit from Parent) K Revert Close inistrator
> DocMoto Client Help inistrator
(3 Emails 11 May 2018 17:10 lee

inistrator
Batman vs The Joker

B ENERGY STAR.pdf

inistrator

YYvvyvwvy

Images

Legal

4. To apply a single set of permissions to the folder (“Accounts” — in this example) for all
groups set the “Default Privileges” to the appropriate value. To modify the permissions

for a single group, highlight the group and select the permissions required using the
lower selection box.

5. Select “Close” to confirm changes.

Note: To reset the permissions to the default settings select “Revert”.
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Setting Permissions — against an existing file

1. Select the file to set permissions against.

2. Select the “Permissions” option from either:
a. The “File” menu.
b. By right mouse clicking on the file and selecting from the popup (or action) menu.
c. The “shift + cmd + p” shortcut.

3. A Permissions dialog is presented as shown in Fig. Permissions dialog (file).

Fig. Permissions dialog (file)

Workshops

localhost 1] & &

DocMoto
& contents
B Home

U Trash

Favourites

Name
m Sample Doc 1.docx
B sample Doc 2.docx
B sample Doc 3.docx
B sample Doc 4.docx
B sample Doc 5.docx

Sample Doc 1.docx

Default Privileges : (Inherit from Parent) &

Group Privileges

engineering (Inherit from Parent)

legal (Inherit from Parent)

t

documents for demo purposes only.
documents for demo purposes only.
documents for demo purposes only.
documents for demo purposes only.
documents for demo purposes only.

manager (Inherit from Parent)
projects (Inherit from Parent)
Active Clients users (Inherit from Parent)

Aardvark vs Baldrick

Active Projects
Batman vs The Joker
B ENERGY STAR.pdf

Images

Last Will And Testaments (Inherit from Parent) &3 Revert Close

Legal

4. To apply a single set of permissions to the file (“Sample Doc 1.docx” - in this example)
for all groups set the “Default Privileges” to the appropriate value. To modify the

permissions for a single group, highlight the group and select the permissions required
using the lower selection box.

5. Select “Close” to confirm changes.

Note: To reset the permissions to the default settings select “Revert”.
Setting Permissions — Template Manager

A template is a process that DocMoto can run when a folder is created. The purpose of a
template is to automate tasks that are always undertaken when a folder is created. Templates

are an excellent way to ensure that commonly created structures are always the same no matter
who creates them.

For example, a template can be created for a project or legal case and will ensure that all
projects or cases look the same with a common structure.

Templates can:

1. Create a sub folder structure within their parent folder.
2. Name sub folders based on criteria such as the parent folder's name or current date.
3. Import files from elsewhere within the DocMoto repository.
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4. Set tags against folders or files.
5. Set permissions against folders or files.

By using DocMoto'’s ability to create folders from templates, administrators can retrospectively
apply permissions changes in the folder template. DocMoto will apply the changes to all folders
created via said template. Retrospective changes will be covered later in this document.

Setting Permissions — Template Manager (folders):

1. Select the “Template Manager” option from the “Admin” menu.
2. Select a folder within the folder template to set (or change) the permissions.
3. Select the “Permissions” tab as shown in Fig. Template Manager (folder) — Permissions

Tab.

Fig. Template Manager (folder) — Permissions Tab

® El contents

localhost | <) 3

SR Add Template Folder Tags |[iciiuiiliily  View Columns

[& contents ¥ Templates Default Privileges : No Access
1 Home ¥ & Demo Template
0 @{foldername} - Client Area

U Tresh » 3 Accounting engineering (Default)
Favourites £3 Contracts legal (Default)

» [ Correspondence manager (Default)

(3 Documents - @{foldername} AIojeats) (Default)

» £ Media users Read, Write & Delete
i+, Estate Administration Probate
£ New Client

Group Permission

Aardvark vs E
Active Clients
Active Projec
Batman vs Tk
! New Corporate Matter
{1 New Country
£ New EL Matter
> 5t New EP Matter
» it New Guardian ad Litem Matter
¥ i New IP Matter

== New Litigation Matter
> & New Matter
* &1 New Mediation Matter
B Letter.docx » &1 New Project
B Letterdocx > &5 New Prospect

B ENERGY STA

YYyvvyy

Images
Last Will And
Legal

Projects

Recen t Document ts

m Aardvark vs E
4 Photo copy 2
4 Benefits Of A

B DocMoto Trai

Add Folder Add File No Access

Apply this template retrospectively on save. See help for details

Requested Tags

Close

4. To apply a single set of permissions to the folder (“Demo Template” parent folder - in
this example) for all groups set the “Default Privileges” to the appropriate value. To
modify the permissions for a single group, highlight the group and select the permissions
required using the lower selection box. In this example, the groups: (a) engineering (b)
legal (c) manager (d) projects have “No Access” set whereas the group “users” have

“Read, Write & Delete”.
5. Select “Close” to confirm changes.

Setting Permissions — Template Manager (files):

1. Select the “Template Manager” option from the “Admin” menu.
2. Select a file within the folder template to set (or change) the permissions.
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3. Select the “Permissions” tab as shown in Fig. Template Manager (file) — Permissions Tab.

Fig. Template Manager (file) - Permissions Tab

® B Contents
localhost |~ ) £ [ &

T Add Template Source & Tags | uIEC Lo
[ contents ¥ Templates Default Privileges : (Inherit from Parent)
1 Home ¥ & Demo Template ~
O Trash (3 @(foldername} - Client Area e permission

¥ &3 Accounting engineering (Default)
Favourites @{foldername} - Invoice.docx legal (Default)
Aardvark vs E 0 Contracts manager (Default)
Active Clients g - Correspondence pmeS (Defa\l] 5
£ Documents - @{foldername}
Active Projec » B Media
Batman vs TF ¥ 1.} Estate Administration Probate
¥ 15 New Client
B enerGy sTA ¥ it New Corporate Matter
Images » £ New Country
Last Will And » il New EL Matter
> =i New EP Matter
Legal » (2l New Guardian ad Litem Matter
Projects ¥ il New IP Matter
» [ New Litigation Matter

Recent Documents » £ New Matter

B Letterdocx » & New Mediation Matter

B Letter.docx * [ New Project
» &4 New Prospect
B Aardvark vs E

3 Photo copy 2
4 Benefits Of A

B DocMoto Trai
Read & Write | <)

Apply this template retrospectively on save. See help for details Close

4. To apply a single set of permissions to the file (“Invoice.docx” — in this example) for all
groups set the “Default Privileges” to the appropriate value. To modify the permissions
for a single group, highlight the group and select the permissions required using the
lower selection box. In this example, the groups: (a) engineering (b) legal (c¢) manager
(d) projects have “No Access” set whereas the group “users” have “Read, Write".

5. Select “Close” to confirm changes.

Setting Permissions — Retrospectively

As the life-cycle of a DocMoto system progresses it can become necessary to update template
definitions and re-apply them to folders. The DocMoto system has a set of tools to make this
possible. To re-apply a modified template is in principle extremely easy. All that is required is to
select a single tick box within the “Template Manager” and save the changes. For a more
detailed listing of the rules for retrospective changes, click here.

The next section will include an example of how permissions can be changed retrospectively via
the “Template Manager”. The example is based upon the demo folder template illustrated in
Fig. Template Manager (folder) — Permissions Tab.

The following projects have been created by the folder template “Demo Template”:

1. Alpha One
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2. Beta One
3. Delta One

As shown in Fig. Projects created by Demo Template.

Fig. Projects created by Demo Template.

ece Projects

< oot B B & | & alalfollalle No N cl ¢ Q

Back lee New Folder Check-In Check-Out Q k  Add Create Views  Shares Lpdate Tags Refresh Search

Contents Projects

DocMoto Name ~ Version Size Checked In On CreatedBy  Comment

’:l Gontents > Alpha One Today, 11:53 lee

- > Beta One Today, 11:54 lee

i Home :

> Delta One Today, 11:64 lee
O Trash

The permissions set against the parent folder (for each project) is:

e engineering — No Access (Default)
e legal — No Access (Default)

¢ manager — No Access (Default)

e projects— No Access (Default)

e users — Read, Write & Delete

As illustrated in Fig. Template Manager (folder) — Permissions Tab and Fig. Project parent folder
permissions.

Fig. Projects parent folder permissions

Alpha One Beta One Delta One

Default Privileges : No Access Default Privileges : No Access ﬂ Default Privileges : No Access
Group Privileges Group Privileges Group Privileges

engineering (Default) engineering (Default) engineering (Default)

legal (Default) legal (Default) legal (Default)

manager (Default) manager (Default) manager (Default)

projects (Default) projects (Default) projects (Default)

users Read, Write & Delete users Read, Write & Delete users Read, Write & Delete

(Default) Revert Close ? (Default) u Revert Close ? (Default) u Revert Close ?

The next section will illustrate how to apply permission changes retrospectively to any project
created via the “Demo Template”.
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Template Manager - retro permissions change.

1. Select the “Template Manager” option from the “Admin” menu.

2. Select a folder within the folder template to set (or change) the permissions.

3. Select the “Permissions” tab as shown in Fig. Template Manager (retro permissions
change) — Permissions Tab.

Fig. Template Manager (retro permissions change) Permissions Tab.

® Projects
localhost o £ & & Y | ¥T 5| ap
— Add Template Folder Tags | Permissions I Columns  Requested Tags
&l contents ¥ Templates Default Privileges : No Access
1 Home ¥ & Demo Template N .
U Trash [ @(foldername} - Client Area Srolip srmission
» 3 Accounting engineering (Default)
Favourites 3 Contracts legal (Default)
ardiar vl » (3 Correspondence manager (Default)
" [ Documents - @{foldername} projects (Default)
Active Clients » Bl Media users. Read, Write & Delete
Active Projec » (L Estate Administration Probate
Batman vs TF ¥ it New Client
B ¥ it New Corporate Matter
ERERGHSTS » £ New Country
Images » (1 New EL Matter

» (1 New EP Matter

Last Will And
» & New Guardian ad Litem Matter
Legal » 2 New IP Matter
Projects » [l New Litigation Matter
» [ New Matter
ERRSRPecuments » [ New Mediation Matter
B Letter.docx » &1 New Project
B Letter.docx » [ New Prospect

n Aardvark vs E
4 Photo copy 2
A Benefits Of A

B DocMoto Trai

Add Folder Add File No Access

Apply this template retrospectively on save. See help for details. Close ?

4. To apply a single set of permissions to the folder (“Demo Template” parent folder - in
this example) for all groups set the “Default Privileges” to the appropriate value. To

modify the permissions for a single group, highlight the group and select the permissions

required using the lower selection box. In this example, the groups: (a) davidson (b)
external (c) inactive have “No Access” set whereas the group “users” will be set to
“Read & Write”. Essentially removing the delete permissions for the “users” group. As
shown in Fig. Template Manager (retro permissions change) Users group.
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Fig. Template Manager (retro permissions change) Users group.

[ ] Projects
localhost a ) aa Py ') £ Y T o) ap (¢ o &
Back ee Mew Folder Check-In Check-Out Quick Look  Add Create  Versions  Views Shares
- Add Template Folder Tags View Columns  Requested Tags
ocMoto
& contents ¥ Templates Default Privileges : No Access B
ﬁ‘ Home ¥ . Demo Template s o
o Trash 3 @[foldername} - Client Area oue ermission
» @ Accounting engineering (Default)
Favourites &3 Contracts legal (Default)
Aardvark vs E (1] Correspondence mar:\ag er (Default)
" (3 Documents - @{foldername} projects (Default)
Active Clients . e Read & Write
» & Media Sers tead & Write
Active Projec » (| Estate Administration Probate
Batman va TH ¥ i New Client

» {1 New Corporate Matter
ENERGY STA » £ New Country

Images » (1 New EL Matter
» &L New EP Matter

Last Will And &

¥ =) New Guardian ad Litem Matter
Lenal » (1 New IP Matter
Projects » [ New Litigation Matter

» [ New Matter

* 1 New Mediation Matter
[ Letterdoex » &1 New Project

B Letter.docx > 4 New Prospect

Recent Documents

n Aardvark vs E

3 Phota copy 2
2 Benefits Of A
B DocMoto Traj

Add Folder Add File Read & Write H

Apply this template retrospectively an save. See help for details. Close ?

5. Once the permissions change is set — select the tick box labelled “Apply this template
retrospectively on save.”.

6. Select “Close”. The user will be prompted to save the changes as shown in Fig. Template
Manager — Changes Pending dialog.

Fig. Template Manager — Changes Pending dialog.

Changes pending...

6 Save changes now?

No ) (I

7. Select “Yes” to confirm the changes.

Once the changes have been confirmed the “Template Manager” will retrospectively apply the
changes to any folders which have been created by the “Demo Template” folder template. As
illustrated in Fig. Projects parent folder - permissions retro change.
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Fig. Projects parent folder - permissions retro change.

Alpha One Beta One Delta One

Default Privileges : No Access Default Privileges : No Access Default Privileges : No Access
Group Privileges Group Privileges Group Privileges

engineering (Default) engineering (Default) engineering (Default)

legal (Default) legal (Default) legal (Default)

manager (Default) manager (Default) manager (Default)

projects (Default) projects (Default) projects (Default)

users Read & Write users Read & Write users Read & Write

Read & Write k& Revert Close 7 Read & Write Revert Close ? Read & Write Revert Close ?

The permissions on the parent folder of each project (Alpha One, Beta One, Delta One) have
been modified with the changes effected in Template Manager (retro permissions change) Users
roup.

Applying Tags to multiple folder for re-application of templates.

The DocMoto system makes it possible to apply tags and their values to multiple folders. To
achieve this highlight the folders you wish to modify, select the “Edit Folder Properties” option
from the “File” menu and add the required tags with associated values.

The Template Name Tag:

DocMoto folder templates are important and extremely popular, whenever a template is applied
to a parent folder a tag called “Template Name” is completed. As such the “Template Name”
tag is an ideal way to identify the folders that have had templates applied.

Re-application of Templates:

The DocMoto system can re-apply templates to the repository and the re-application uses the
“Template Name” tag to indicate which folders should be considered.

Combining the two:

The two concepts listed above can be combined to enable administrators to tag a folder with an
appropriate “Template Name” and retrospectively apply that template to that folder.

The main benefit being that it is an ideal way to simply re-organise a repository that was not
originally created using templates.

The next section includes an example of how administrators can utilise this functionality.
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Apply Tags for Re-application of Templates — Example:

The following folders were created as standard folders:

1. Nu One (as shown in Fig. Projects created as standard folders)

2. Omega One
3. PiOne

Fig. Projects created as standard folders

& Q
Attach Search

Projects t

ece Projects
< bearost B £ & & @ B8 DA ®| | &
Back lee New Folder Check-In Check-Out Quick Look  Add Create Versions  Views  Shares Update Tags Refresh
Contents.
DocMote Name ~ Version Size Checked In On Created By ~ Comment
| contents v Alpha One Teday, 11:53 lee
[ Accounting Today, 11:63 lee
1 Home » [0 Alpha One - Client Area Today, 11:53 lee
U Trash > Contracts Today, 11:53 lee
. > Correspondence Today, 11:53 lee
B » Documents - Alpha One Today, 11:53 lee
Aardvark vs Baldrick > Media Today, 11:563 lee
Active Clients A Beta One Today, 11:54 lee
n i » Accounting Today, 11:54 lee
e Projects » [ Beta One - Client Area Today, 11:54 lee
Batman vs The Joker (2 Contracts Today, 11:54 lee
B ENERGY STAR.pdf » [l Correspondence Today, 11:54 lee
» [0 Decuments - Beta One Today, 11:54 lee
Images 3 Media Teday, 11:54 lee
Last Will And Testaments ¥ [ Delta One Today, 11:54 lee
Legal » Accounting Today, 11:54 lee
» Contracts Today, 11:54 lee
Projects 3 Correspondence Today, 11:54 lee
e Documents: > Delta One - Client Area Today, 11:54 lee
> Documents - Delta One Today, 11:54 lee
0 Letterdocx b Media Today, 11:54 lse
B Letter.docx v Bl Nu One Today, 14:08

¥ I Omega One Today, 14:08
v B Pi One Today, 14:08 lee

n Aardvark vs B...- Invoice.docx
- Photo copy 2.jpg

1 Benefits Of A...t System.pages

[ DocMoto Train...Plan.doc.docx

0 « B Root > [ Contents » [ Test Folder > [l Projects

3 selected

Changing Tag Restrictions:

Administrators must change the tag restrictions on the tags:

1. Template Name
2. Created By Template?

To achieve this:
. Select “Tag Manager” from the “Admin” menu.

Navigate to the “Created By Template?” tag.

Select “Restrictions” tab.

oOunnhwWN=

Restrictions tab.
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. Select “Show Protected Tags” tick box (this will expose the system defined tags).
Select “Advanced” and an “Advanced Settings” dialog is presented.

Select “set when Creating a Folder?” check box. As shown in Fig. Advanced Settings —




7. Repeat steps 3 to 6 for the tag “Template Name”.

Fig. Advanced Settings — Restrictions tab.

Tag
DocMoto Show Protected Tags :
[ conte v e v Name: Created By Template?
B Home d Version Name
7 Checked Out By m text
U Trash 7 Content L
7 DAV Checked Out Date
T 7 Checked Out Date Advanced Settings
Aardy Version Depth
Activé > Audit Tl Restrictions |
Active " ‘t AVl
» 7 Office Tag can be...
Batmi » & PDF
B ENER > E-Mﬁi‘ seen in Details pane?
¥ & Picklists
Image 3
Approval Status used in Advanced Search?
Lasty Attorney
Legal _. Background Colour added as a Column?
L ¥ ¢ Calendar Events
Prolet 4. Client
ecent pocd Created By Template? set on Check-In Document?
D Letter : Default Email To .
DO NOT DISPLAY set when Creating a Folder?
M Letter DO NOT DISPLAY
B Aardv DO NOT DISPLAY Allow multiple occurrences
. DO NOT DISPLAY
AT Document Type
1 Benef 7 Email Subject
B pocMm 7 Email Text Cancel [ ok ]
” File ID
? File Size
i :sz?r‘;pe Delete Tag

Bewacsand Solaus

Close

8. Select “OK"” to confirm restrictions change.
9. Select “Close” (“Tag Manager).

The administrator will be prompted to save the changes. Select “Yes” to confirm the changes.
Applying Tags to multiple folders:

Administrators can set the “Created By Template?” & “Template Name” tags to folders within
the system.

1. Select the folders which require the tags “Created By Template?” & “Template Name”
for re-application of a folder template.
2. Select “Edit Folder Properties” option from either:
a. The “File” menu.
b. By right mouse clicking on the folders and selecting from the popup (or action)
menu.
c. The “shift + cmd + e” shortcut.
3. A “Folder Tags” dialog is presented enabling the user to add (or remove) folder tags.
Select the “+" button (bottom left hand corner of dialog) to add tags.
4. An “Add Tags to this Folder” dialog is presented enabling the user to select the tags to
add as folder tags. Navigate and select “Created By Template?” & “Template Name”
tags. As shown in Fig. Add Tags for this Folder.
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Fig. Add Tags for this Folder.

8 & e e B BAIY B ® © & ¢
DocMoto Folder Name:
[ Contents Folder Tags
1 Home Apply any tags and complete their values to help with this folder's categorization.
g o
T Trash Tag Value
[t [ ] Add Tags for this Folder...
Aardvark vs Baldrick v ApRIUVEl Slaius
Active Clients & Attorney
Aetive Projects @ audit
ve Projec <7 Background Colour
Batman vs The Joker »  &” calendar Events
ENERGY STAR.pdf » & Client
& Created By Template?
Images & Default Email To
Last Will And Testaments <7 Document Type
oo > P E-Mail
i <7 Email Subject
Projects < Email Text
Recent Documents \j E\l‘EdID T
<7 Folder Type
n Letter.docx - a ypl -
B Letter.docx

concel (KD

m Aardvark vs B...- Invoice.docx
[ Benefits OFf A...t System.pages

Note: Tags can be created by Administrators using Tag Manager.
B DocMoto Train...Plan.doc.docx g E <) 1L g

Cancel OK ?

5. Select “OK"” (Add Tags for this folder — dialog) to add tags.
6. Enter the following as values against the “Created By Template?” & “Template Name”
tags:
a. Created By Template? = true
b. Template Name = <name_of the_template> (in this example = Demo
Template) as shown in Fig. Adding values to the “Created By Template?” &
“Folder Name" tags.

Fig. Adding values to the “Created By Template?” & “Folder Name” tags”:

@® Projects

localhost ) g oy @ 0 ' “T ) P

Back ee New Folder Check-In Check-Out Quick Look Add Create Versions Views Shares Upda

DocMoto Folder Name:

£ Contents
1 Home

T Trash

Apply any tags and complete their values to help with this folder's categorization.

Tag Value

Favourites Created By Template? true
Aardvark vs Baldrick Template Name Dema Template

Active Clients

Active Projects

Batman vs The Joker

ENERGY STAR.pdf

Images

Last Will And Testaments
Legal
Projects
Recent Documents
n Letter.docx
B Letter.docx
m Aardvark vs B...- Invoice.docx
“ Photo copy 2.jpg =
[ Benefits OFf A...t System.pages

Note: Tags can be created by Administrators using Tag Manager.
B DocMoto Train...Plan.doc.docx B J <1 g
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7. Select “OK” to apply the tags and values against the selected folders.

Fig. Folder Tags “Created By Template” & "Folder Name"” and values applied to folders -
illustrates.

CHL Software
www.docmoto.com



Fig. Folder Tags “Created By Template” & “Folder Name” and values applied to folders:

[ IR ] Projects
< barot B B & & o B DDA RO = & Q
Back lee New Folder Check-In Check-Out Quick Look  Add Creste  Versions  Views  Shares s Refresh  Attach Search
Contents Projects +
DocMoto Name ~ Version Size Checked In On Created By ~ Comment
B contents > Alpha One Today, 11:53 lee
~ > Beta One Today, 11:54 lee
@ Home > Delta One Today, 11:54 lee
U Trash v B Nu One Today, 14:08 lee
v Omega One Today, 14:08 lee
i v I PiOne Today, 14:08 lee
Aardvark vs Baldrick
Active Clients
) ) “ A v & B Root > [ Contents » J Test Folder » [l Projects > Wl Nu One
Active Projects 6 ) & !
Batman vs The Joker Details
& ENERGY STAR.pdf ¥ Full Details
Images
Name Nu One
Last Will And Testaments Created By Template? true
Legal Template Name Demo Template
Projects R
Created By  lee
Recent Documents Checked In On Tue Jul 17 14:08:42 BST 2018
Letter.docx ¥ Initial Version
B o . Nu One
B Letter.docx Initial Check In Tue Jul 17 14:08:42 BST 2018
m Aardvark vs B...- Invoice.docx
7 Photo copy 2.jpg
1 Benefits Of A...t System.pages
B DocMoto Train...Plan.doc.docx
1 selected

Re-Application of folder template — Example:

Administrators can now retrospectively apply the folder template “Demo Template” to the
system.

1. Select the “Template Manger” from the “Admin” menu.
2. Select the template to apply the retrospective changes.

3. Select the tick box labelled “Apply this template retrospectively on save.”. As shown in
Fig. Applying the "Demo Template” retrospectively.
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Fig. Applying the “Demo Template” retrospectively:

® Projects
localhost o £ <2 & | Y ap ¢
E— Add Template WiellE oy Permissions  View Columns  Requested Tags
[&] contents ¥ Templates
1 Home ¥ &l Demo Template
O Trash L @{foldername} - Client Area Tag Value
» (3 Accounting Import Question Select a(n) @{foldername} Project Folder
Favourites 3 contracts Project ID fold datetime: %Y%m%d%H%EM%S
Aardvark vs E » [ Correspondence @({foldername} - @{datetime: m )
(3 Documents - @{foldername Project Manager ser
Active Clients > - - ef } luser}
: ) 3 Media o Project Status Open
Active Projec » [} Estate Administration Probate
Batman vs TF ¥ i New Client
o * &L New Corporate Matter
S » &L New Country
Images » (1 New EL Matter
Last Will And ew EP Matter
* New Guardian ad Litem Matter
Legal 1 New IP Matter
Projects * it New Litigation Matter
» [ New Matter
S Tpan * 1 New Mediation Matter
[ Letterdoex » £1 New Project
B Letter.docx » [ New Prospect
n Aardvark vs E
" Phota copy 2
1 Benefits Of A
B DocMoto Trai
Add Folder Add File + —  Tags and Values that apply to the new folder
Apply this template retrospectively an save. See help for details. Close ?

4. Select “Close”.
5. The user will be prompted to save the changes as shown in Fig. Demo Template —
Changes Pending dialog.

Fig. Demo Template - Changes Pending dialog:

Changes pending...

Save changes now?

4

No | R

6. Select “Yes” to confirm the changes.

DocMoto will check for any folder which has been created by the folder template “Demo
Template” and retrospectively apply the necessary changes. As the folders in this example have
been marked as being created by the template “Demo Template” (use the two folder tags
“Created By Template?” & “Template Name”) the folder structures will be changed to match.
As shown in Fig. Retrospective change results — Demo Template.

Note: If the administrator has not changed any of the folder templates properties (i.e. new
folders or files, permissions, column views, document or folder tags, etc) then they will receive a
message to reflect this point. As shown in Fig. Apply changes anyway dialog.
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Fig. Retrospective change results - Demo Template:

e Projects
localhost [ ] g & 0 Y T o @ @
Back
Contents. Projects
Nu One d
DocMoto Name It
El contents > Alpha One Default Privileges : No Access u
— » Beta One
& Home » I Delta One Group Privileges
U Trash ¥ [ NuOne engineering  (Default)
# [0 Accounting legal (Default)
Favourites . Contracts
. manager (Default)
Aardvark vs Baldrick > Correspondence projects (Default)
Active Clients » B Documents - Nu One users Read & Write
) . » Media
Active Projects > Nu One - Client Area
Batman vs The Joker v Omega One
B ENERGY STAR.pdf > I Accaunting
> Contracts
Images » Correspondence B
7
Last Will And Testaments > Documents - Omega One Read & Write EJ Revert Close ?
Legal » Media
[ 4 Omega One - Client Area Today, 14:26 lee
Projects v Pi One Today, 14:08 lee
Recent Documents * IR Accounting Today, 14:26 lee
L4 Contracts Today, 14:26 lee
M Letter.docx » BN Correspondence Today, 14:26 lee
B Letterdocx » [ Documents - Pi One Today, 14:26 lee
. > ? :
m Aardvark vs B...- Invoice.docx Media Today, 14:26 lee
» Pi One - Client Area Today, 14:26 lee
7 Photo copy 2.jpg
1 Benefits Of A...t System.pages
B DocMoto Train...Plan.doc.docx
O <« ~ v o B Root > [{ Contents » Test Falder » Projects » [ Nu One
1 selected

- 5]

The projects: (1) Nu One (2) Omega One & (3) Pi One have been retrospectively changed to
match the folder template “Demo Template”.

Fig. Apply changes anyway dialog:

DocMoto

The template "Demo Template" has not changed,
would you like to retrospectively apply it to the
repository anyway?

No ) R

Summary:

The example illustrated above deals with converting a standard folder into a complex
hierarchical folder with business rules applied (permissions, sub-folders, custom column views,
folder & document tags). It is possible to create a folder template with just one folder with
custom permissions and apply this template retrospectively to either standard or hierarchical
folder(s). The retrospective rules ensure no sub-folders or business rules (folder and document
tags) are removed only added.
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Permissions Report:

DocMoto has a sophisticated built-in reports system. Designed specifically to provide essential
management information, the reporting feature is another tool to help increase efficiency,
improve customer service and drive down costs.

The next section will cover the permissions based report.

Running the Permissions Report:
To run the permissions report:

1. Select the “Permissions Summary by Group” menu item from the “Reports/Folder:
<name_of folder>/" menu. As shown in Fig. Permissions Report — Menu Item. Note:
The “<name_of _folder>" listed above is the name of the folder where the report is run
from, in this example the “Contents” level folder. This example gives the user a global
permissions matrix.

Fig. Permissions Report - Menu Item:

& DocMotoClient File Edit View Import Server Admin Window Help Tam P $ 1 MFT W1 B3 H Tess2z Q @ =
D ® JocMoto Client - localhost
. Email Import Audits > _
< localhost <] £ & Emails > LB (3] g o Q
Back lee New Folder *  Folder: Contents »> Checked Out Details Search
Matter > Checked Out Summary Proj L
: rojects +
New Project > Contents Bt
DOCMOD Shares > Multi Level Summary 2
[ contents . ConteniJup AP [ Permissions Summary by Group
& Home S ﬁ ::::: Time Spent »  Template Usage
Users > Text Analysis
T Trash

Top Level Summary

2. A report will be created and the result set will be displayed to the user. As shown in Fig.
Permissions Report — Result Set.
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Fig. Permissions Report - Result Set:

Parameters =

legal manager
Read, Write & Delete  Read, Write & Delete

projects
Read, Write & Delete Read, Write & Delete

users

)

Read, Write & Delete
Administer
Administer

[ ] [ ] Folder: Contents/Permissions Summary by Group
Folder permissions by user group
Folder (Default) engineering
[Contents/ Read, Write & Delete  Read, Write & Delete
/Contents/1. OCR Inbox/ No Access
/Contents/Admin/ No Access [
/Contents/Assembly/ No Access
/Contents/CHL Software/ Mo Access
[Contents/Contractsf Mo Access
[Contents/Legal/ Mo Access
/Contents/Legal/Active Clients/A - D/Aardvark vs Baldrick/ No Access

/Contents/Legal/Active Clients/A - D/Aardvark vs Baldrick/Accounting/
[Cantents/Legal/Active Clients/A - D/Aardvark vs Baldrick/Correspondence/
/Contents/Legalf/Active Clients/A - D/Aardvark vs Baldrick/Correspondence/Emails/
/Contents/Legal/Active Clients/A - D/Aardvark vs Baldrick/Court Documents/
/Contents/Legal/Active Clients/A - D/Aardvark vs Baldrick/Notes & Internal Memos/
/Cantents/Legal/Active Clients/A - D/Aardvark vs Baldrick/Production & Client Docs/
jContents/LegalfActive Clients/A - D/Aaron vs Melchett/

/Contents/Legal/Active Clients/A - D/Aaron vs Melchett/Accounting/
/Contents/Legal/Active Clients/A - D/Aaron vs Melchett/Correspondence/
/Contents/Legal/Active Clients/A - D/Aaron vs Melchett/Correspondence/Emails/
/Contents/Legal/Active Clients/A - D/Aaron vs Melchett/Court Documents/
/Contents/Legal/Active Clients/A - D/Aaron vs Melchett/Notes & Internal Memos/
/Contents/Legal/Active Clients/A - D/Aaron vs Melchett/Production & Client Docs/
fContents/Legal/Active Clients/A - D/Barton, Clint/

[Contents/Legal/Active Clients/A - D/Batman vs The Joker/

ICantentsiL Clients/A - D
& localhost > [ Contents

vs The Joker ina/

Save to Clipboard

)

|

No Access

)

No Access
No Access

198 rows found

Read Only

Read, Write & Delete
Read, Write & Delete
Read, Write & Delete
Read, Write & Delete
Read, Write & Delete
Read, Write & Delete
Read Only

Read, Write & Delete
Read, Write & Delete
Read, Write & Delete
Read, Write & Delete
Read, Write & Delete
Read, Write & Delete
Read, Write & Delete
Read Only

Read. Write & Delete

(b)

Refresh Close
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(a) Any whitespace within the “Permissions” report denotes the default permissions are set
(i.e. Inherit from Parent — folders permission). Therefore, the folders:

Contents/Legal/Active Clients/A — D/Aardvark vs Baldrick/Accounting/
Contents/Legal/Active Clients/A — D/Aardvark vs Baldrick/Correspondence/
Contents/Legal/Active Clients/A — D/Aardvark vs Baldrick/Correspondence/Emails/
Contents/Legal/Active Clients/A — D/Aardvark vs Baldrick/Court Documents/
Contents/Legal/Active Clients/A — D/Aardvark vs Baldrick/Notes & Internal Memos/
Contents/Legal/Active Clients/A — D/Aardvark vs Baldrick/Production & Client Docs/

Has the “No Access” permission set for the groups:

e engineering

o legal
e manager
e projects

This is due to the parent folder “Contents/Legal/Active Clients/A — D/Aardvark vs Baldrick/”
having the “No Access” permission set. Subsequently all child folders inherit the same
permissions.

Whereas the “users” group has the “Read, Write & Delete” permission set against the folders
listed above.

(b) Any whitespace within the “Permissions” report denotes the default permissions are set
(i.e. Inherit from Parent — folders permissions). Therefore, the folder:

Contents/Admin/

Has the “No Access” permissions set for all groups (including the “users” group). Only
administrators will be able to view this folder.

And the folder:
Contents/Legal/Active Clients/A — D/Aardvark vs Baldrick/

Has the “No Access” permissions set for the groups:

engineering
legal
manager
projects

Whereas the “users” group has the “Read Only” permissions set. This will ensure the child
folder level cannot be manipulated (deleted, moved).
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